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Projekt History 
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1. Summary 

1.1 Functional description 

This sample project intended to show how IO modules are configured in device 
configurator and how to use IO handling functionality in device configurator to 
read/write IO signals.  

To read and write digital/analogue values using the IO modules and device 
configurator, it is essential to have a basic understanding of Device configurator. This 
topic is dealt with in section 2.1 (Device configurator). 

1.2 Quick Steps 

In general following easy steps in device configurator will allow you to configure and 
read/write IO values to respective IO modules. 

• Enable IO handling (By default its enabled when new device is created) 

• Place Input/Output modules in respective IO slots in device configurator 

• Enable media mapping for each IO module 

• Define media address 

• Define PG5 symbol Names for each IO channels (Or keep Default) 

• In case of analog modules select suitable scaling 

• Save the configuration 

• Device must have program with at least one COB 

• Mapped media/PG5 public symbols can now be used in programs. 

• Re-build All and download program to target controller 

1.3 Possible application 

The device configuration for various IO modules described in this example can be 
used in any project with digital and/or analogue IO signals. 

1.4 Hardware and software used 

Hardware: 

• PCD3.M5540, PCD3.C200 

• One or several I/O modules, depending on the requirement 

• PCD8.K111 programming cable or USB cable (for PCD3 or PCD2.Mxxx0) 

• Where input modules are used, a signal transmitter is required. 
To use these examples with a controller type other than a PCD3.M5540, the relevant 
device type should be selected in the device configurator. 

Minimum software version: 

SAIA PG5 2.0.110 or higher 

PCD3: minimal FW 1.08.23, PCD2.M5: minimal FW 1.08.19 
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2. Device configurator  

2.1 Introduction 

The Saia Device Configurator is used to configure the hardware settings of Saia 
PCD. It also offers the possibility to configure the IO modules with the IO handling 
functionality. We will discuss configuring IO modules with the IO handling 
functionality using device configurator. 

Detail Online help on device configurator is available from Help menu. 

 

2.2 IO handling in device configurator 

The IO handling functionality defines peripheral memory for storing IO values. It 
defines one range for input values and one range for output values. Within those 
peripheral memory ranges (input and output), a range of address are reserved for 
each configured module for its input and/or output values. 

The media mapping functionality enables a mapping between the peripheral memory 
values and the device resources (registers and flags). When media mapping is 
enabled input values from peripheral memory will be copied to respective PCD 
resources (Registers or Flags) at the beginning of a cycle, it means before the first 
COB is executed.  

For Output modules values from PLC resources will be copied to output peripheral 
memory at the end of program cycle that is at the end of last COB.  
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2.3 Working with Device configurator 

Device configurator has various views namely Main window, Selector window, 
Properties window and message window. Main view has context menu and actions 
like Device type change are performed from context menu. Each component is 
selected in main view and properties window at right shows all parameters. The 
editable parameters are adjusted from here. For example select the Device say 
PCD3.M5540 in main window, all hardware settings properties are displayed in 
properties window. 

All possible modules which can be placed in one of the slots are available in selector 
window. These include digital and analog IO modules, communication modules, IO 
extension modules etc. Modules from selector window are placed in device slots by 
selecting the respective slot and double mouse click on module in the selector 
window. Once the module from selector window is placed in device slot, properties of 
module are configured from properties window. 

2.4 Configuring IO modules 

IO handling needs to be enabled to use the IO handling functionality with media 
mapping for IO modules. It is only available for PCD3 and PCD2.M5. Select the 
appropriate device type in main view and by default IO handling is enabled for newly 
created device in device configurator. The peripheral addresses definition should be 
“Auto”(recommended and default), when user defined is selected it is possible to 
configure input/output peripheral memory address manually. 

Next step is to place the required IO modules in desired slot. When these modules 
are selected in main view its properties are displayed in properties window. Select 
Media mapping Enabled as YES and provide the base media addresses. PG5 
Symbol names for each input/output are defined from symbol definition property, by 
default symbol Names appear like IO.Slotx.DigitalInputx or IO.Slot2.AnalogueInputx.  

In case of analogue modules scaling is done for each channel in properties window. 
Predefined or user defined minimum and maximum values are selected for minimum 
and maximum physical signals. More about configuring and using IO modules is 
described in next chapter.
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3. Functional description and settings 

3.1 Principles of reading/writing I/O modules 

When media mapping is enabled SAIA PCD works with a process map. Inputs are 
read at the start of the cycle and outputs are updated at the end of cycle. 

3.1.1 Digital I/O modules 

For digital IO modules Flags are used for media mapping and these mapped flags 
can then be used in user program for reading/writing values to IO modules. In 
following example digital input module PCD3.E110 is placed in Slot0 and Media 
mapping is enabled from properties window. Media Address is defined as 0 which 
means flag 0 to 7 are mapped with Input 0 to 7 of PCD3.E110 module 

 

Similarly for digital output modules, values written to the mapped flags will be written 
to respective outputs. In above example flags 8 to 15 are mapped to PCD3.A400 
module’s Output0 to Output7.  

Symbol definitions for mapped flags are modified from the properties window. Below 
example shows the example of defining symbols for digital inputs module 
PCD3.E110. Following dialog is opened from Properties window by selecting Symbol 
definition property. These symbols are available in program editors and they are then 
used in user program. 
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3.1.2 Analogue Input modules 

All analogue modules can be configured and used using device configurator. Similar 
to digital modules they are placed in respective slots and needs to be configured 
from properties window. In below example Configuration for PCD3.W340 module is 
shown. Register 8 to 15 are mapped with analogue input 0 to 7 of PCD3.W340 
module. Registers 8 to 15 then are used in programs. Symbol definition for register 0 
to 7 can be edited from Symbol definition property. Scaling for analogue IOs can be 
configured in device configurator. In below example first analogue input is configured 
as 0 to 10 Volts that means values in the Register 8 will vary from 0 to 10000 for 0 to 
10 Volts respectively. The other inputs work in the same way. 
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Scaling properties of analogue modules varies for different types of modules. Symbol 
definitions for mapped registers are modified from the properties window. These 
symbols will be available in program editors and can be used in the user program. 
Below example shows the example of defining symbols for analogue inputs module 
PCD3.W340. This dialog is opened from Properties window by selecting Symbol 
definition property. 
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3.1.3 Analogue Output modules 

In below example output module PCD3.W400 is configured using device 
configurator. Values from the register 16 to 19 are written to output module 
PCD3.W400. Output0 is configured as 0 to 10 volts with corresponding minimum and 
maximum values 0 and 10000 respectively. Writing values 0 to 10000 to register 16 
will output 0 to 10 volts at the first output. Similarly for next outputs it will output 0 to 
10 Volts based on the corresponding values in the range of minimum and maximum 
values. It is also possible to configure user defined minimum and maximum values 
(Output 2). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Saia-Burgess Controls AG 

Bahnhofstrasse 18 l CH 3280 Murten l Schweiz 

T +41 (0)26 672 71 11 l F +41 (0)26 672 74 99 l www.sbc-support.ch l www.saia-pcd.ch  

 

PCD2_PCD3-IO_Signals-In_Device_Configurator_EN1.doc 9/16 19.01.2010 

3.1.4 Direct Access 

It is also possible to read input values and write output values directly using IL 
instruction. Following instructions along with Address of input/output defined by 
device configurator are used for reading and writing IO values. 

These instructions works independent of program cycle scan and they read 
or write inmmediately after execution. This means that you can read and 
write values several times in the same program scan cycle using these 
instructions.  

Following instructions are available for reading and writing IO values.  

For reading:  

RDP address;    

 DWORD, per default. 

RDPB address; 

 BYTE, LS byte of source, other bytes set to 0. 

RDPW address; 

 WORD, LS word of source, MS bytes set to 0. 

For writing:  

WRP address; 

 DWORD, per default. 

WRPB address; 

 BYTE, LS byte of source, other bytes set to 0. 

WRPW address; 

WORD, LS word of source, MS bytes set to 0. 

 

There is no bit access command and minimum access range is byte. 

 

 

 

Example: 

Device configurator generates constant symbol for ID/Address of the input/output 
values and these symbols are available in ‘All public’ View. In below example for the 
module PCD3.W340 which is placed in slot 5, constant Symbols 
IO.Slot5.IOAccess.ANALOGUE_INPUT_0 to 7 are defined by Device configurator. 
These symbols are used along with above instruction to directly read/write values.  



 

 

Saia-Burgess Controls AG 

Bahnhofstrasse 18 l CH 3280 Murten l Schweiz 

T +41 (0)26 672 71 11 l F +41 (0)26 672 74 99 l www.sbc-support.ch l www.saia-pcd.ch  

 

PCD2_PCD3-IO_Signals-In_Device_Configurator_EN1.doc 10/16 19.01.2010 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Saia-Burgess Controls AG 

Bahnhofstrasse 18 l CH 3280 Murten l Schweiz 

T +41 (0)26 672 71 11 l F +41 (0)26 672 74 99 l www.sbc-support.ch l www.saia-pcd.ch  

 

PCD2_PCD3-IO_Signals-In_Device_Configurator_EN1.doc 11/16 19.01.2010 

4. Device configurator vs Fbox Library for IO signals 

Following sections describe the advantages and limitations of using device 
configurator for accessing IO signals compared to Fbox Library. This will help in 
choosing between Device configurator and Fbox library. 

4.1 Advantages of Device configurator 

• The complete system is visible in the same tool 
Device configurator is designed to configure your overall system. Hardware 
settings and system components like communication modules and IO modules 
are configured in device configurator. When device configurator is used for 
configuring IO modules, it gives the overall picture of your complete system 
and its components. This is not possible when we use Fbox library to access 
IO modules. 

• Power consumption of the modules is automatically calculated 
The Device Configurator makes check for power consumption of the 
input/output modules and issues warning if it exceeds available power supply 
from Device or expansion modules. 

• Less resources needed for the IO handling 
Fboxes for accessing IO modules are part of user program and they use PCD 
resources. When IO modules are configured using Device configurator, 
processing of IO signals is handled by firmware and IO values are directly 
available in PCD media. It saves the user program memory and resources. 

• Working with a process image 
With the device configurator when media mapping is used, SAIA PCD works 
with process image. Inputs are read at the start of program scan cycle and 
outputs are written at the end of program scan cycle. It is advantageous to 
have constant input process image throughout the one program cycle and 
updating outputs only once with final state after executing entire user 
program.1 

• IO symbols are all defined at the same place 
Symbol definitions for Input/Output channels are edited from the symbol editor 
dialog opened within Device configurator from IO module properties window. 
In this way all input and output symbols are defined at one place in Device 
configurator near to respective IO modules. This is convenient to locate and 
manage all process input and output symbols. 

• Easier configuration of PCD3 Compact or counter/encoder modules 
Apart from this device configurator offers the easy configuration for using 
special functions like counters/encoders. For example counter/encoder 
functions easily configured and used in case of PCD3 Compact or with special 
PCD3.H1xx modules. 

                                            
1
 Please note that it is always possible to read/write IO signals many times in same program cycle 

using direct access instructions. 
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• Warning in case of conflict 
A warning or an error is also displayed when a module may have some 
conflict with the watchdog. 

• Label Editor 
An extension application Label editor is useful to edit and print the labels for 
your IO modules. Label editor is available in Device configurator from menu 
Tools�Label Editor. 

 

4.2 Note for special sensors 

Although device configurator supports the all standard IO sensors, there are few 
special sensors (e. g. temperature sensors NTC 10) which are not supported in 
device configurator. We recommend in such special cases please use the existing 
Fbox libraries to access your process data. For more information on Analog signals 
using Fupla Fboxes please refer to Getting Started example 
‘Analogue_Signals_with_Fupla’ 

4.3 Precaution  

Following care must be taken while using the Device configurator for 
analogue modules. 

  

It is recommended to use Device configurator for accessing analogue I/O modules 
with PG5 2.0. However in order to compatible with programs from old PG5 versions it 
is still possible to use Fbox libraries which uses base addresses of I/O bus. When 
using the both methods in one program care must be taken that addresses do not 
interfere with each other. This means for example if Fbox in fupla program is using 
Base address 48 to read the analog values from Slot3 then Slot3 in Device 
configurator should be kept empty. 

If the Programs from PG5 versions 1.4.xx or older are upgraded to PG 2.0 and if they 
were using the Fbox libraries to read the Analog I/O modules, they are still 
compatible with PG5 2.0. 
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5. Preparing Project 

5.1 Preparing the PCD 

The module to be used should be inserted into respective socket where it is 
configured in Device configured on the PCD3.M5540.  

More information regarding the modules and the wiring information are available on 
our support site www.sbc-support.ch. 

 

Analogue input modules are especially sensitive to earth loops. Please be 
sure to follow the wiring instructions. 

 

The I/O bus on the SAIA PCD Classic controllers is not designed for “hot 
plugging”. Before inserting or removing I/O modules, the controller should be 
disconnected. 

 

5.1.1 Installation of the project 

To install the project in your PG5 project directory, you should use the “Restore...” 
function from the “Project” menu in the PG5 2.0 Project Manager. This function will 
copy the project into your project directory. 

 

This document can be found in the “Documents” folder in the project tree for the PG5 
Project manager, and is opened directly from there by double-clicking on it. 

http://www.sbc-support.ch/
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5.1.2 Building and loading the project into the PCD 

After making necessary configuration for module configurations in Device 
configurator, the device is loaded into the controller following a “Rebuild All” (Menu 
“Device�Rebuild All”….option, or Alt+F2 in Project manager). 

If the controller is already in a “Run” state, the system will ask whether the controller 
can be stopped. This will be the case during testing. The message is displayed for 
safety reasons, as it may not be permissible to stop the controller while in use on an 
existing installation. 

5.2 Viewing values online 

Once the program is loaded into the controller, an online connection needs to be 
established to the controller, in order to view the values online. Clicking on the 
"Online" button (with the plug) connects the PC to the PCD. If the PCD is not yet in a 
Run state, it is started with the curved green arrow on the toolbar. 

The Watch Window (see next section) can now be used to view the values online. 

5.2.1 The SAIA Watch Window 

To display and change the values from media on a screen, the Watch Window is 
used. Watch window is opened from the “View” menu in the PG5 Project Manager. 
The symbols to be displayed are “dragged and dropped” into the window. 
As soon as PG5 is online, the relevant values will be displayed.
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5.2.2 The PG5 Online Debugger 

Another way of displaying values online is the Online Debugger (select “Tools”, 
“Online Debug” in the PG5 Project Manager, or press F11). 

 

The Online Debugger is a very versatile tool, providing the following options: 

- Controlling the PCD (stop, start etc.) 
- Displaying PCD media (registers, flags, DBs etc. can also be refreshed) 
- Writing to PCD media  
- Modifying the program (if it is held in RAM) 
- Displaying the CPU status (hardware and firmware version etc.) 
- Reading the PCD history 
- Displaying the current hardware configuration 
- Program “trace” (step-by-step processing; not allowed when accessing 
analogue I/Os) 
- Processing individual instructions 
- Running the program up to a given event (e.g. change of specified media or 
to setting of Error Status Flag) 

To display the values read in the Online Debugger, the following input is required 
(enter only the characters in bold): 
> Display Register <address of register to be displayed> Refresh <Enter> 

The address of the register to be displayed can be seen e.g. in the “Data List View” 
within the PG5 Project Manager (select “View”, “Data List”). 
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6. Errors and debugging 

To help to isolate and fix faults quickly, this section describes a number of frequently 
occurring errors. 

6.1 Common errors 

Here is a list of frequent causes of malfunction in the example described: 

Error Cause and resolution of error 

The analogue output value is 
always =0 or maximum 
amplitude 

The analogue input value is 
always =0 

May be caused by incorrect wiring of the module. 
Please check the wiring against the hardware 
manual for your PCD. 

The value read from one or 
more analogue inputs jumps 
periodically and is not constant 

This phenomenon could be caused by an “earth 
loop” in the system. Please check the earth of your 
system. The earth to the “-“ side of the module 
must have a short and massive connection to the 
“-“ terminal on the PCD (no looping of the earth 
wire around the PCD!) 

6.2 Troubleshooting / debugging 

When troubleshooting, it is advisable to start with device configuration and one empty 
COB. After downloading the configuration and program to PCD the IO values in 
respective media can be checked. The values in the PCD can be verified by means 
of the Watch Window or the Online Debugger. 

To be sure that there is a signal at the input, the input signal should be verified with a 
Multimeter while commissioning. 

6.3 Sources 

The various procedures for operating the modules are specifically tailored to the 
hardware used in the modules concerned.  

Hardware-specific details such as terminal assignments and wiring diagrams can be 
found in the hardware manual for the relevant controller. 
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